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Welcome
Welcome to Zign Track 2
Thank you for purchasing Zign Track 2. Zign Track 2 is the latest
technology for making facial motion capture easier than ever
before. If you follow the instructions in this manual carefully,
performing facial motion capture with Zign Track 2 will be a
piece of cake.
Zign Creations will be updating this product constantly by adding
new features. If you have any feature requests or suggestions
we are always happy to hear them and if possible include them
in a next update. We hope you have great fun using this
product.

What's new?
Zign Track 2 has a completely redesigned user interface for an
improved work flow. The new layout gives you all the controls
where and when you need them.
Zign Track 2 comes with many new features. You can perform
facial motion capture in real-time and preview the results in realtime. Advanced tweak tools let you adjust the offset and
exaggeration for each facial area. You can tweak the captured
motion before, during and after recording.

Installation
Installing Zign Track
Installing Zign Track is a straightforward process. Before
installation, be sure to save any work in progress and close all
running applications, including virus-checking utilities. If you
want to make use of the online activation you should disable any
firewall software.
If you have a download version you can double click the setup
executable to begin setup. If you have a CD-ROM hard copy,
insert the CD-ROM into your CD-ROM drive (or DVD drive) and
the setup should automatically start. If you have disabled autorun on your system the setup will not automatically start. In this
case you will need browse to your CD-ROM drive and double
click setup.exe, or in the Start menu type "X:\setup.exe", where
'X' is the letter that's assigned to your CD-ROM drive. On
Windows XP you need to choose "Run..." from the start menu
before you can enter the setup command.
The setup process is very straightforward. After accepting the
Zign Track 2 End User License Agreement (EULA) you can click
next on every step to accept the default settings. You can
choose to change the destination location and some other
settings but the default settings have been designed to suit the
needs of the majority of users.

The new Zign Track has more export formats, which we are
always expanding. In addition, the export formats have become
much more advanced, giving more control over your characters
and better compatibility with the major 3D animation
applications.
Contents
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System Requirements

Getting started

PC

Minimum Requirements

Operating System:

Windows XP, Vista or 7

Windows XP, Vista or 7

Single camera or video:
Dual-core processor (Intel or
AMD 2 GHz or more)

Single camera or video:
Dual-core processor (Intel or
AMD 2.8 GHz or more)

Computer Memory:

1 GB

3 GB or more

Screen Resolution:

1024 x 768

1920 x 1080

Graphics Adapter:

Single camera or video:
256 MB DirectX 9.0c compliant
video card

Graphics input
devices*:

USB or FireWire input for the
camera, depending on the
connection type for
the
camera.

USB or FireWire input for the
camera, depending on the
connection type for the
camera.

Camera:

640 x 480 resolution or higher
at 25 FPS or more

720p at 30 FPS or more

Computer Processor:

Recommended

Single camera or video:
512
MB
DirectX
compliant video card

Activating the software
When you launch Zign Track 2 the first time, you will be asked to
enter your registration details. If you have entered your name
and company during installation these will be filled in already.

9.0c

Enter your serial number in the field marked with "Serial:". If
you have a download version you should have received your
serial number while purchasing the software. If you have a hard
copy version you can find your serial number in the CD-ROM
case. If you have lost your serial number, contact your reseller or
Zign Creations for support.
In the last field you will need to enter your activation key. To
Contents
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obtain your activation key you will need to submit your
registration details. If you have an Internet connection, click the
"Submit online" button. Your default browser should now open
and take you to the activation key request page on
zigncreations.com. If all your details are filled in correctly in the
activation window these will be already filled in for you on the
request page in your browser. Now enter your email address
(and then confirm it to ensure it is recorded accurately) and click
"submit". Your activation key will then be sent to you by e-mail.

Project types
With Zign Track 2 you can create 2 kinds of project types:
1: Facial Motion Capture from a live video source
2: Facial Motion Capture from a video file
To start a new project, press 'Ctrl + N' or use the menu Project
> New project...

Should you encounter some problem with your browser you may
choose the "submit by email" option instead. When you click this
button Zign Track will launch your default email client and
automatically fill in the email for you. All you have to do now is
send the email. If you do not have a email client installed but
want to use web-mail or e-mail from another computer, use the
"copy to clipboard" option. Now your registration details will be
copied to your clipboard and you can paste them in any text field
in your web-mail or text application. Please note that if you
request your activation key via e-mail these requests are
handled manually so it can take some time before you receive
your activation key. So use the "submit online" option whenever
possible.
The activation key you will receive will only work on the
computer you are registering on. If you want to transfer your
license to another computer, or if your hardware fingerprint has
changed you can repeat the process above to obtain a new
activation key.
When entering your activation key in the software, use copy and
paste to ensure maximum accuracy.

Contents

You can name your project here and choose a directory for the
project. Zign Track will create a subfolder with your project
name by default. This can be disabled by unchecking this option.
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Facial markers

adhesive that is not meant for use on the skin.

Marker types and tips

Another simple solution is to use small, colored self-adhesive
marker labels. You can find them in most office supply stores.

Before you start doing motion capture with Zign Track 2, you
should be familiar with the kind of markers to use, their correct
method for placing them, and any possible pitfalls.
Zign Track 2 automatically detects
markers when they are in view. The
markers can only be detected if they
have the correct color, size and are
clearly visible. The best detectable
markers are round balls. For this you can
use small colored beads or any other
small balls of negligible weight. A good
option is to use painted polypropylene
beads. A quick search on the Internet
should give you enough addresses for
suppliers. You may have to paint them
yourself.

It is important that these markers are always clearly visible, if
you stick them flat onto the face the ones on the sides of your
face will easily become undetectable. Here's what you have to
do: Take two of these marker labels, stick them with the halves
together and fold the other halves outwards like shown in the
picture below. Now you will have a round edge pointing
outwards that will make sure the marker is more clearly visible
even when not facing the camera directly.
If the markers don't stick well enough to the skin you can use
skin adhesive for these marker labels too.
The recommended marker size is 4 - 8 mm (0.15 - 0.30 inch).
With a high video resolution you should use small markers, with
a low resolution you should use larger markers.

You can glue these beads to the face using special latex
adhesive. You can find this latex skin bond adhesive in party
make up stores. Do not use latex adhesive if you have a latex
allergy. There are some alternatives for latex adhesives in make
up stores, like silicone based adhesive. Do not use any other
Contents
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Marker colors

Background and clothes

You can use the following marker colors with Zign Track 2: red,
green, blue, yellow and pink. You'll see later on there is an
option in the configuration window to select 'white' as marker
color, but this is for special cases only. You can only use white
markers if they have a black dot in the center, or if you are using
a special infrared camera with illuminated markers that produces
black an white video.

Because Zign Track 2 automatically detects the markers you
have to make sure no other objects within the visible range of
the camera share the same color as your markers. For example;
if you are using green markers, you can not wear green clothes
or have any green objects in the view. If other objects with the
same color are visible the tracking algorithm may mistake them
for markers and this will cause the tracking to fail. If needed,
use a curtain or screen behind the actor to avoid the tracking to
be messed up by other objects or passers-by.

The option to use markers with a black dot was added to Zign
Track 2 because several users of version 1 have asked for this
feature. Despite this we recommended to use normal colored
markers because in practice this has proven to be more reliable.
Why can't I use white markers in normal circumstances you ask?
Here's why: Zign Track 2 uses a marker detection algorithm that,
as the name suggests, automatically detects the markers. It
detects the markers based on the selected color and size. If you
were to use white markers and your eyes and teeth were visible
you would have a tracking problem from the start because the
tracking algorithm may detect markers in your eyes and mouth,
causing incorrect solution of the face.
We recommended you should use green markers. The color
green has proven to be the most reliable in detection and this
color normally does not occur on the skin. If you would choose
to use red markers you'll notice that if your skin has a warm
color, there's already so much red in your skin the tracker may
detect random markers there. If you choose to use another color
in stead of green, be careful what you pick. You can use the
marker preview function later to test which color works best for
you.

Contents

Right: No other objects share the same
color as the markers.

Wrong: The shirt and markers are the same
color. This will cause problems with the
tracking of the markers.
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Marker layouts
Create a new project in Zign Track, if you have not already done
so. In the lower right corner of the main window you will see a
thumbnail image with a face and some green markers. If you're
using Zign Track for the first time, it will already have selected a
default marker layout. Click the "Edit layout" button below the
thumbnail preview to select another marker layout. The "Edit
marker layout" window will now show.

In the drop down list in the upper right corner you can also
select from several predefined templates.
Once you have selected a layout you can click the "Accept"
button to apply your marker layout. The edit window will now
close and Zign Track will build a new facial rig in the 3D preview
window.
In this rig you will see blue
and
red
boxes
that
represent the markers. The
markers in your selected
marker layout will all be
represented here. The blue
boxes on the sides of the
chin are always present.
The red boxes represent
rigid body markers. Most of
them are not in your marker
layout and you don't need
to place them on the actor's
face. These markers will be
used when the final motion
capture data is exported, if
enabled.
You can rotate the face rig
in the 3D preview with your
mouse. Right clicking this preview window will open a pop up
menu with some option to reset the rotation and hide or show
different parts of the face rig.

Contents
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Camera setup
Camera types
Zign Track 2 supports 2 types of cameras: Web cameras and DV
cameras.

Web cameras
Web cameras can be used in real-time mode, or you can
prerecord your videos using a web camera. Most web cameras
are very cheap and do not perform well. However, there are
some very good web cameras available. If you want to get good
results using a web camera here are some things you should
bear in mind:
First of all, make sure your web camera can record video in a
high resolution, with a reasonable frame rate. A lot of
manufacturers advertise with both, even if their product can not
do both at the same time. For cheap web cameras you can
choose between a higher resolution or a lower one with a better
frame rate. Get a good web camera and you'll have both. But,
even with some good web cameras the frame rate will drop
when you choose the highest resolution. That said, you don't
always need the highest resolution.
Most modern web cameras have nice built in features like autofocus, auto-exposure and color enhancement. If you want to get
good results from your web camera, the first thing you need to
do is turn off auto-focus and auto-exposure. The auto-focus
function on most web cameras will go through the entire focus
range a couple of times each minute to pick the focal distance
with the sharpest image. The problem with this is that your

Contents

video will be out of focus a couple of times each minute and
when the camera is out of focus Zign Track may not be able to
track your markers.
Auto-exposure can be a good thing when there's plenty of light.
However, in low light conditions this auto-exposure function will
increase the exposure time (shutter time) so much that it may
exceed the frame time for your selected frame rate. This will
cause the frame rate of your camera to drop, which in turn will
cause you to lose details in your captured motion. This is why
you have to make sure there is enough light when using web
cameras, or just let the image go a little darker as long as Zign
Track is still able to track your markers. With good markers this
should be no problem at all.

DV cameras
DV cameras usually have a fixed resolution in NTSC or PAL
format. This resolution should be enough to get accurate motion
capture data if you use the correct markers. The great
advantage compared to web cameras is the optical zoom most
camcorders have. If you are not using a head mounted camera,
you can place the camera further away from you and zoom in to
allow the face to fill the frame. You may want to disable autofocus if that's not working well for your camera, i.e.: throwing it
out of focus every once in a while. Another great advantage
compared to web cameras is that you can adjust the exposure
without affecting the frame rate.
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Arrangement

The available capture devices will be listed in the list box on the
right. If you have plugged in a new device while this window
was already open, click the "Refresh" button. Now the new
device should be added to the list.
Zign Track 2 allows you to select one camera. If you want more
cameras to improve the accuracy or increase the actor's range of
head rotation, you can upgrade to Zign Track Pro, which allows
you to use up to eight cameras.
When using a web camera, you will have to place the camera
relatively close to the actor because usually these kind of
cameras have wide angle lenses. There are two important things
you will have to pay attention to when using wide angle
cameras:
1: The actor should keep the same distance to the camera. At
short distances the size of the markers on the video frames will
change quickly if the distance changes. This can cause the
marker size to go out of the range of the specified marker size in
the tracking options.
2: Because of the quick change in marker size related to
distance, the marker on the neck of the actor will be smaller in
the video. Although the tracking algorithm is forgiving on this it
is wise to use a slightly larger marker on the neck to avoid any
tracking problems on the neck marker.

You can use Zign Track 2 with a static camera or head-mounted
camera. Head-mounted cameras can be great for use in
combination with full body motion capture.
To set up the camera arrangement start live-capture project
first. In the Zign Track main window click the "Select input
devices" button (located on the left of the preview thumbnail).
Now the camera selection window will show.
Contents

When using a DV camera with optical zoom (or maybe a new
kind of web camera with optical zoom) and a static setup, it is
best to place the camera at some distance from the actor. A
distance between 1 and 2 meter (3.5 or 6.5 foot) would be
good. Use the optical zoom function the get the face as large as
possible within view. With the larger distance the focal angle of
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the camera will be smaller. This will make sure the markers will
keep the same size in the video, even when the actor moves a
bit away or towards the camera.
Whatever kind of camera you are using, always try to position
the face so that it fills the viewfinder without losing sight of any
of the markers.
The remaining steps in camera selection will be discussed in the
chapter Facial motion capture from live input.

Facial motion capture from live input
To perform motion capture from a live video source you will have
to create a 'live video source' facial motion capture project from
the project creation window.
After creating this project, the interface will show a time line,
video window and a 3D preview window.

Lighting
To get reliable tracking results you will have to ensure the
lighting is good, and that your markers are visible.
You will have to make sure there is enough light to detect the
markers. In the tracking options you can change the tracking
sensitivity if needed. With a high sensitivity setting Zign Track
will be able to track most markers even in low light conditions. A
greater danger to your motion capture is overexposure. If your
markers are overexposed i.e.: getting too much light, they will
begin to appear white in stead of your selected marker color.
This will cause the tracking algorithm to lose track of your
markers.
If you're using image based eye tracking you should make sure
the face is well lit. Also, do not over expose the skin. Bright
highlights on the skin in the eye area can confuse the eye
tracker.
Bright colored markers can be easily over exposed. If you need
more light for the eye tracking while this over exposes your
markers you should use darker colored markers to avoid
problems.
Contents

Select layout
Before you can do any motion capture you will have to select (or
design) the correct marker layout. To select a marker layout click
the "Edit layout" button in the lower right corner of the main
window. The marker layout should match the markers on the
actor's face exactly. The marker positions do not have to be
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100% accurate and 100% symmetric. Any deviation will be
corrected later on. If you have specified a different number of
markers the tracking algorithm will become corrupted and the
output will be unusable. Select a marker layout that will suit your
need for details or that will best match the face rig of your final
3D characters. Use the image in the marker edit window as a
reference when placing markers on the actor's face.
Tip: pressing 'Alt + Print Screen' (or 'Alt + F14' on a Mac
keyboard) will capture the image of this window to your
clipboard. You can then paste it in an image editor and print it.

3D Preview
As soon as you have selected a new marker layout and returned
to the main window, a new 3D face rig will be built in the 3D
preview window. For more details on this see the paragraph on
marker layouts. This face rig will move along with the actor as
soon as there's any valid data being captured by the cameras.
This will be your main reference while performing motion
capture.

Select camera
When the marker layout is set and the actor ready (with facial
markers) you can enable the video input and prepare for
recording motion capture data. In the main window click the
"Select input devices" button to select your camera. For details
on how to select and setup your camera, see the chapter
Camera setup.
After selecting the camera you may want to edit the camera
settings. Click the "Video settings" button in the camera
selection window.
Contents

You can change the resolution and color mode for your camera
by selecting a mode from the drop down list. It is recommended
to use a 24 bits color mode. On the right of the mode drop down
list you can select a frame rate for your camera. The frame rates
listed in the drop down list are derived from your camera's
driver. The available frame rates may change if you change your
camera's resolution. If you change a resolution you can click the
"apply" button so the available frame rates will be verified. If you
do not verify the available frame rates after changing a
resolution, Zign Track may not be able to set the camera to the
selected frame rate if it was not available for this mode. In this
case Zign Track will use the camera's default frame rate.

Camera properties
If your camera's driver contains property pages you can access
these pages by clicking the "Properties" button. These windows
are not part of Zign Track. They are part of the camera's driver.
If there's a problem with one of the functions here you should
update your drivers or contact the developer for support.
In these property pages you can change all kinds of parameters
for your cameras. Which parameters are available depends
totally on the camera's driver and available functions.
If you want to be able to change these properties during the
motion capture session, you can. When you're back in the main
window with the cameras running you can access these property
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pages via the menu Capture > Camera properties > Camera 1.
When all camera settings are correct, click "OK" in the camera
selection window to accept the camera and enable the camera
input. It could occur you get an error message because the
camera could not be connected. If this happens, try a different
video mode for the camera.

Preview markers
With the cameras running and the actor in view, the face rig in
the 3D preview window should show some movement. The rig
may be distorted at first- you will correct this later on. First you
want to make sure the markers are being detected correctly. To
see if the markers are being detected correctly you will need to
enable the marker preview. Go to the menu View > Show
detected markers (or press 'Ctrl + F2'). The 3D preview will now

disappear and another video display will show up in the preview
window.
In the marker preview every marker that is detected will be
indicated with a small colored dot. These dots will have a
different color on each part of the face. By looking at the colors
you can verify if Zign Track has correctly detected your markers
according to the specified marker layout. The color of the
markers should match the selected color in the Tracking options.
Here is what each color represents:
Olive:
Black:
Blue:
Navy blue:
Red:
Light red:
Purple:
Maroon:
Green:
Aqua:
Yellow:
Orange:
Gray:
White:
Lime:
Teal:
Fuchsia:

Neck
Nose
Chin
Jaw
Upper lip
Lower lip
Mouth corner
Cheek
Squint
Nose wrinkle
Nostril
Eye corner
Lower eyelid
Upper eyelid
Eyebrow
Forehead
Unknown: feature could not be determined

If all markers are detected correctly you should see these colors
on all of your markers. You should see none with the color
fuchsia- if you do, it means Zign Track was not able to determine
to which marker in the specified marker layout this marker
should be linked.
Contents
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In some situations one or more markers cannot be detected
because a marker is not clearly visible. Zign Track will first
attempt to determine which the neck, chin, nose and forehead
markers are. It then continues to find the eyebrow markers and
works it's way down the face. When some markers are not
visible, a part of the face may not be detected correctly. Another
marker may even be mistaken for the one Zign Track was
looking for. When this happens Zign Track will notice it gets in to
trouble while linking each marker and it will not apply the
marker positions of the facial areas that appear to be incorrectly
tracked. While this happens you will notice some markers in the
preview will have incorrect colors and some remaining markers
will be colored fuchsia. This should be no problem if it's only for
a couple of frames where the actor poses an extreme pose. The
missing data will be interpolated to the new position when
detected correctly.
If you are getting the wrong colors on your markers all the time,
something is going wrong. This can have different causes:
1: Badly placed markers

Make sure you have placed the markers according to the
specified marker layout. It does not have to be 100% accurate,
but deviate too much from the layout and tracking will fail.
Make sure the markers are placed in such a way they are visible
at any time. For example: do not place the lower lip markers too
low, as when pouting with the lips the markers may become
obscured. Do not place the upper and lower lip markers too
close to each other as they may become to close when pressing
the lips together. Do not place the neck marker too high; this
marker could become obscured by the jaw when the mouth
opens too much.

Contents

For the markers placed towards the sides of the head, as with
the eye corner markers and cheek markers you should not use
flat markers. In stead use markers that are still visible when not
facing the camera directly. See the chapter Facial markers for
more details on this.
2: Badly colored/lit markers

The markers should have clear colors and must be lit in a way
these colors are clearly detectable. The markers should have a
good contrast with their surroundings. See the chapter Facial
markers for detailed instructions.
3: Noise

Tracking 'noise' can have different causes in Zign Track. If other
objects or surfaces in the video contain colors that are close to
the specified marker color, it causes the tracking algorithm to
detect markers on these objects where no actual markers are
present. This will cause a complete tracking failure and you will
need to eliminate this noise before proceeding. First of all,
remove any objects with similar colors to the specified marker
out of range of the camera. If that does not solve the problem
and marker dots are randomly appearing on near white surfaces
you should check your cameras' color balance or white balance.
An incorrect color balance could produce a color tint almost
invisible to the eye but yet strong enough for the tracking
algorithm to pick up.
Another possible cause for tracking noise is noise in the actual
video footage. If your camera is producing too much noise try to
eliminate this noise or get a better camera.
If all possible causes above are eliminated and Zign Track is still
picking up noise you may want to reduce the sensitivity of the
tracking algorithm. You can alter the sensitivity in the Tracking
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options.
4: Incorrect tracking settings

Most important of all, your tracking settings should match your
marker type. Make sure you set the tracking settings in the
configuration window correct. If needed, adjust the tracking
sensitivity. See how to change the Tracking options in the
chapter Configuration.

Range of movement
The range of head movement is limited to the point where the
markers on one side of the face are no longer visible. With only
one camera you will have to remember not to turn around too
much. If some markers are not visible for a couple of frames it
should be no big problem because the missing data gets
interpolated. Fast movements can cause blurry images on which
the markers cannot always be detected. Again, this should be no
problem for a short fast movement because Zign Track will
interpolate to the new position so you can hardly notice any
frames where missed. If you want to be able to capture faster
movements you will need a higher frame rate or if possible
reduce the shutter time on your camera to produce less blurry
images.

closed (if it was still open) so the face rig becomes visible in the
3D preview window. It may well be that the bones and markers
in the face rig are not oriented as you would expect in a neutral
pose. This is easily corrected.
First, the actor should take a neutral pose with all face muscles
relaxed and look right into the camera. Now you can set the
neutral pose via the menu Capture > Set neutral pose (or press
F5). The face rig should straighten up right away. You can undo
this via the menu Capture > Reset neutral pose (or press F6). If
the neutral pose was not correct you can set it again without
having to reset it first.

When using a head-mounted camera the actor can turn around
as much and as fast as needed. Just ensure the neck marker
does not go out of sight.

Setting the neutral pose
Now all markers are being detected correctly (the colors must be
correct in the marker preview), the marker preview can be
Contents

Before setting the neutral pose

After setting the neutral pose
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Using the tweak tools
You can use the tweak tools to fine-adjust the offset
of each part of the face and if preferred the
exaggeration tools can be used to increase or
decrease the amount of applied motion for each part
of the face.
To bring up the tweak panel go to the menu View >
Tweak panel (or press F3). The tweak panel will now
show on the right of the 3D preview window. The
available tweak tools are based on the selected
marker layout. A simple layout will have a few tweak
tools and an advanced layout will have many tweak
tools.
On the bottom of the tweak panel you will see four
buttons: "None", "Recording", "Block" and "All
recorded". When "None" is selected, changing the
tweak sliders will have no effect. When "Recording"
is selected, the tweak sliders will affect the incoming
data immediately. You can use this to adjust any
incorrect offset that was not completely corrected by
setting the neutral pose. Use the exaggeration
controls if you wish. The "Block" and "All recorded"
options do not have any effect before any motion
capture data is recorded. If you are recording or wish
to adjust the tweak controls prior to recording,
always make sure the "Recording" button is pressed.
To set a currently selected control back to zero, press
'0' on your keyboard to reset the slider. To reset all
tweak parameters at once, right click the tweak
panel and select "Reset all parameters".

Contents
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Recording
When everything is set up correctly and the face rig is
responding like expected to the actor's movements you can
begin recording. Press the red record button above the time line.
After each processed video frame the 3D motion capture data
will be recorded with its time stamp, regardless of the specified
frame rate for your project.
While recording you will see a random colored block appear on
the time line. This block represents the data that is currently
being recorded. Each time you start recording, a new block will
be added to the time line.
To stop recording simply press the stop button next to the record
button. Now you can replay the recording and tweak it if
needed. To delete a recorded block from the time line, right click
the block and select "Delete block".

Playing back and tweaking the recordings
If there are any recorded blocks on the time line you can play
them from the time line. Use the playback controls to play,
rewind, jump to the next block, etc. As soon as you start playing
from the time line, select one of the blocks with your mouse or
start dragging the time line, the 3D preview will no longer show
any real-time motion capture input. If you want to switch the 3D
preview back to live input, select from the menu View > 3D
preview live stream (or press F7).
Now you have some recorded motion capture data you can still
use the tweak tools to correct any motion if necessary. To edit
just one of the blocks, click this block in the time line with your
mouse. The time scale above this block will turn yellow,
indicating this block is selected.
Contents

Click the "Block" button below the tweak controls to activate the
tweak controls for just this block and tweak the block as you
please. You can do this for each block. The tweak parameters
will be stored for each block so when you go back to a previous
tweaked block the sliders will be back the way you left them.
Note: No tweak values are directly applied to your recorded
data. The values of each control will be stored within your
project so you can always go back to the original input if
needed.
It is also possible to tweak the motion capture data for all
recorded blocks at once. To do this, click the "All recorded"
button below the tweak controls. Any change in the controls will
now affect all recorded data. The tweak values per block and all
recordings are cumulative. You can tweak all recorded blocks at
once and still adjust per block if needed.
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Editing recorded block properties

Facial motion capture from a video file

For each recorded block you can change its title and color. The
title of each block will be added to the file names when
exporting, making it easier to recognize what the contents of
each exported file is. To edit the properties of a recorded block,
right click the block and select "Block properties..." from the
pop-up menu.

To perform motion capture from a prerecorded video file, create
a new project and select "Facial Motion Capture from a video
file" in the project creation window. To import a video, go to the
menu Project > Import video (or press Ctrl + I).

Now you can enter a new
title. Note you cannot have
duplicate titles. To edit the
color, click the colored box
next to "Color:". Click the
OK button to accept the
changes.

File formats and CODECs
Zign Track 2 can import videos in the formats AVI, MPEG and
WMV. To be able import the file, the correct decoder (CODEC)
must be installed on your system. The most occurring CODECs
are already installed on most systems. If Zign Track is unable to
find the required CODEC for your video file, see the
Troubleshooting guide for a solution.

Frame rate

Notes before recording

For live-capture projects the default frame rate is 30.0 FPS. You
can change the frame rate for your project any time. To edit the
frame rate, click the frame rate box on the left of the marker
layout thumbnail preview. The FPS edit window will now show.

If it is the first time you are performing motion capture with Zign
Track 2 and have not done any real-time capture yet it is
recommended you do a real-time capture from a live video
source before you start any prerecorded video based projects. It
is much easier to get acquainted with how Zign Track works and
what will and will not work in real-time. If you're starting out
wrong it can be quite frustrating if you have to shoot a new
video first before you can do your next attempt.

Enter the desired frame rate and
click "OK" to accept. Changing the
frame rate will not affect any
recorded data or the frame rate
while recording. It only affects the
frame rate for exporting.
The minimum allowed frame rate is 1.0 FPS and the maximum is
120.0 FPS.

Contents

An important note for those who have upgraded from
Zign Track 1: Zign Track 2 is not just an upgrade to Zign Track
1. The tracking algorithm is very different. It automatically
detects your markers and you will not be able to adjust any
badly tracked markers manually. Because the markers are
automatically detected, some other objects in the video may be
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detected as unintended markers. Such videos may track well in
Zign Track 1 but will fail in Zign Track 2. If your old videos are
not suitable for use in Zign Track 2, do not attempt to track them
as it will only cause frustration. Zign Track 2 works very
differently from Zign Track 1, so it is beneficial to get
accustomed to the new system, even if you are familiar with the
previous version. Make sure you follow the instructions in this
manual carefully and you will notice getting new your videos
tracked in Zign Track 2 is much easier compared to Zign Track
version 1.

is now responding to the actor's movement, it is highly likely the
bones and markers in the face rig will not be oriented as you
would expect in a neutral pose. This is easily corrected.
First pause the video at a position where the actor's pose is
neutral. Now you can set the neutral pose via the menu Capture
> Set neutral pose (or press F5). The face rig should straighten
up right away. You can undo this via the menu Capture > Reset
neutral pose (or press F6). If the neutral pose was not correct
you can seek another frame in the video and set the neutral
pose again without having to reset it first.

3D Preview
As soon as you have selected a new marker layout and return to
the main window, a new 3D face rig will be build in the 3D
preview window. For more details on this see the paragraph on
marker layouts. This face rig will move along with the actor in
the video if the markers on the actor's face match the selected
marker layout and are being detected by the tracking algorithm.

Preview markers
Before you can process your video you will need to make sure all
of your markers are being tracked correctly. You can use the
marker preview to verify this while you adjust your tracking
settings if needed. This is described in detail in the chapter
"Facial motion capture from live input" in the paragraph Preview
markers. Follow these instructions carefully and you should be
able to track the actor's movement.
Before setting the neutral pose

After setting the neutral pose

Setting the neutral pose
If all of the markers are being detected correctly and the face rig
Contents
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Processing the video

Configuration

If all of your settings are correct and your prerecorded video
fulfills all requirements, you should now be able to play back the
video while the face rig in the 3D preview nicely follows all
movements. This does not mean you're ready, first Zign Track
has to process the video to and store the captured motion data.
To do this, click the "Process video" button above the time line.
A small window will show the progress during processing. When
Zign Track is done processing your video the video block on the
time line should now be green, indicating it has been processed.
If you want to undo the processing because you would want to
change the neutral pose or retry using different settings, just
click the process button again (which now says "Clear") to clear
the data. The video block will now turn red again and you can
change any setting you want before processing the video again.

To enter the configuration window, go to the menu Project >
Configuration or press F4. In a live-capture project you can also
access the configuration window using the "Configuration"
button on the left of the marker layout preview thumbnail.

Tracking options
The configuration window will open by default on the tracking
options page.

Using the tweak tools
When your video has been processed successfully you can use
the tweak tools to change rotation offsets and increase or
decrease the amount of motion per facial area. This is described
in detail in the chapter "Facial motion capture from live input" in
the paragraph Using the tweak tools. The only difference is for
projects based on a prerecorded video you can only change the
tweak values for the video block after the video has been
processed.

Markers
In the Facial markers area you can set all the settings for your
markers. Select the correct color and size. The marker size
should be set in pixels, according to the size they appear in the
actual video footage, not as they appear on the screen. The
Contents
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marker size does not have to be 100% accurate. The main
reason you have to indicate the marker size is so the marker
tracking algorithm knows what to look for. However, setting a
marker size too small could cause jitter and setting the size too
large could cause problems detecting the markers all the time. If
you're not sure, just try a couple of values and pick the value
that works best for your footage.
Next to the color selection box there's a sensitivity control. If
you're having trouble getting your markers tracked because
there's not enough light or the marker color is too dark, try
increasing the sensitivity. At maximum sensitivity Zign Track is
able to detect markers even in very low light. Nevertheless, you
should always endeavor to have good lighting to get the best
results. Be careful not to set the sensitivity too high as it will
increase the risk of picking up noise.
If the marker tracking algorithm is picking up markers where it
should not pick up makers, this could be caused by noise in the
footage. Decreasing the sensitivity may solve this problem. If it
does not, try to reduce the noise as much as possible (good
lighting can make a big difference) or adjust the color balance
on your camera.
The sensitivity slider will have effect on the moment you're
changing it so you can see the effect without having to close the
configuration window. Next, you can set the marker type. Select
"Normal" to use normal round markers. You can use the "Black
mark" marker type, but as stated in the chapter "Facial markers"
in the paragraph Marker colors this is not recommended.

Smoothing and error correction
In the Real time tracking area you can adjust the settings for
Contents

smoothing. Error correction will be performed if smoothing is
enabled. Error correction involves interpolating movements in
gaps where a part of the face or the whole face could not be
tracked. Also, error correction prevents badly tracked frames
being applied to the face rig end ending up in your final
exported data.
It is not recommended to disable smoothing, unless your
footage is 100% perfect on all frames. If you do, you should use
a high resolution camera to get stable results.
When smoothing is enabled you can set the number of frames
over which smoothing and error correction must be performed
with the spin box on the right. The actual recorded data will
have a lag of this number of frames. The preview will have the
same lag by default.
You can preview the input without lag while smoothing is
enabled by switching the Real-time preview option to "Direct".
You should note that this will show any error that is being
detected right on the face rig in the 3D preview. This is a good
way for you to verify how reliable your actual footage is without
any error correction. You'll soon notice that even in the best
footage there will always be some frames that could not be
captured 100% correctly which will cause the bones in the face
rig to twitch every now and then. You don't have to worry about
this, error correction is still being performed but you don't see
this with direct preview enabled. If you record now and play
back after that you'll see the recorded data looks much better
compared to what you saw without lag. Having some lag in the
preview should not be a problem and if you want to know how
your actual recorded motion capture data will look like it is best
to always leave the Real-time preview option to "Lag (smooth)".
Only use the direct preview option to verify the reliability your
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footage.

3D preview

Eye tracking

On the 3D preview page you can change the colors for the face
rig in the 3D preview.

If you are not using eyelid markers Zign Track can use image
recognition to track the eyes. You can enable this on the Eye
tracking page.

Click the colored boxes to change the color for each feature.

Graphics
When using image based eye tracking the eyelids and pupils will
move simultaneously for both eyes. This method will produce
the most stable results in the most varying conditions. Pupil
tracking will only work properly in good lighting conditions with
higher resolutions. The pupil tracking is not 100% accurate and
is meant only to quickly bring some live to the eyes without
having to animate them by hand for the entire animation. If you
want accurate eyelid tracking per eye, you should use eyelid
markers instead.
Contents

On the graphics page you can select the video renderer.
Changing this setting will not reduce or increase overall
performance. It it set to software by default.
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Exporting
When you are done processing your prerecorded video based
project or recording real-time motion capture and everything is
tweaked and set, it is now time to export your motion capture
data so you can use it in your preferred animation application.
For real-time motion capture projects note that you should give
each recorded block a title that will help you recognize the
contents. Each block will be exported as a separate file and the
titles will be added to the file name you choose.
To export your motion capture data go to the menu Project >
Export motion capture data and select the format you want to
export in.

Contents
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BVH

In the BVH export window select the motion capture blocks you
want to export. For projects based on a prerecorded video there
will only ever be one block. If you want the rigid body bones
and the lip curl bones to be exported too, make sure you enable
these options.
Click the "Export BVH" button to export your motion capture
data. A save file dialog window will now show, allowing you to
select a destination and file name.
For real-time motion capture projects the file name will be preset
as "Auto name". If you leave the file name like this Zign Track
will save each recorded block with its title as file name. If you
specify a file name yourself Zign Track will add the title of each
block to the file name.
Contents

C3D

In the C3D export window select the motion capture blocks you
want to export. For projects based on a prerecorded video there
will always be only one block. If you want the rigid body markers
and the lip curl markers to be exported too, make sure you
enable these options.
If you want 2D data instead of 3D data you should select the
"2D motion" option. In this case you may want to have
eliminated the head movement using the exaggeration tools
prior to exporting.
Click the "Export C3D" button to export your motion capture
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data. A save file dialog window will now show, allowing you to
select a destination and file name.
For real-time motion capture projects the file name will be preset
as "Auto name". If you leave the file name like this Zign Track
will save each recorded block with it's title as file name. If you
specify a file name yourself Zign Track will add the title of each
block to the file name.

TRC

will always be only one block. If you want the rigid body markers
and the lip curl markers to be exported too, make sure you
enable these options.
If you want 2D data instead of 3D data you should select the
"2D motion" option. In this case you may want to have
eliminated the head movement using the exaggeration tools
prior to exporting.
Click the "Export TRC" button to export your motion capture
data. A save file dialog window will now show, allowing you to
select a destination and file name.
For real-time motion capture projects the file name will be preset
as "Auto name". If you leave the file name like this Zign Track
will save each recorded block with its title as file name. If you
specify a file name yourself Zign Track will add the title of each
block to the file name.

In the TRC export window select the motion capture blocks you
want to export. For projects based on a prerecorded video there
Contents
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Poser PZ2

Morphs

The exporter for Smith Micro's Poser ® will generate PZ2 files that
can be added to your Poser ® Library or you can import them in
DAZ StudioTM.
Selection

On the "Export selection" tab you can select which recorded
blocks you want to export. For projects based on a prerecorded
video there will always be only one block.

Contents

On the "Morph settings" tab you can create your own morphs to
match any of your models. Under "Source" click one of the fields
and a drop down list will show up. In this list you can select one
of the 70 base morphs Zign Track generates. When you have
selected a base morph Zign Track will fill in the default values
and target morph name. You will have to make sure the target
morph name matches the morph name of your model exactly. If
the morph names are not exactly the same your model will not
move. The base morph names in Zign Track control the data in
the same direction as it is written. For example:
"BrowDownUpLeft" means a negative value when the brow is
down and a positive value when the brow is up. If the direction
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is reversed on your model you can invert the min and max
values to correct this. The min and max values specify the range
of the outputted values in normal conditions. If your movements
are extreme or exaggerated a lot the outputted values may
exceed the specified min and max range.

Morph list
This list contains all available base morphs and specifies the
required markers to drive the morph.
Base morph

Required markers

A note to DAZ StudioTM users: A morph value of 1 means 100%
and -1 means -100%. Do not enter a range of 100 unless you
really want to exaggerate your morphs by 10,000% (probably
not).

Jaw Down

Chin (1 or 3)

JawLeftRight

Chin (1 or 3), eye corners

ChinUp

All 3 chin markers

BrowDownUp

Any brow marker (average is used)

You can create as many morph targets as you wish. You can
even let one base morph control multiple target morphs. For
example, let the BrowDownUp morph control both the eyebrows
and the wrinkles on the forehead. A target morph can only be
used once.

BrowDownUpLeft

Any non centered brow marker (average is used)

BrowDownUpRight

Any non centered brow marker (average is used)

BrowDownUpCenter

Center brow marker or inner brow markers

BrowDownUpCenterLeft

Inner brow markers

BrowDownUpCenterRight

Inner brow markers

If you have set up all the morphs for your model you should
save this as a preset so you do not have to specify all morphs for
this model another time. You can create presets for as many
models as you like. To save a preset click the "save preset"
button and specify a name for your preset.

BrowDownUpOuter

Outer brow markers

BrowDownUpOuterLeft

Outer brow markers

BrowDownUpOuterRight

Outer brow markers

BrowFurrow

Center brow marker or inner brow markers

BrowFurrowLeft

Inner brow markers

BrowFurrowRight

Inner brow markers

Squint

Any squint marker (average is used)

SquintLeft

Any squint marker (average is used)

SquintRight

Any squint marker (average is used)

Blink

Upper eyelid markers or image recognition

BlinkLeft

Upper eyelid markers or image recognition

BlinkRight

Upper eyelid markers or image recognition

EyelidUpperDownUp

Upper eyelid markers or image recognition

EyelidUpperDownUpLeft

Upper eyelid markers or image recognition

EyelidUpperDownUpRight

Upper eyelid markers or image recognition

Some DAZ models will need a prefix like "PHM" or "PBM" for
each morph name. You can specify this prefix in the text field
below the morph list. If you're unsure which prefix your model
needs, contact the maker of your model.
Each base morph is based on the movement of one or more
markers. If the required markers for a selected base morph do
not occur in the marker layout for your project, these morph
drivers will contain no motion data in your exported file. To make
sure the morphs you have selected can all be driven you should
check them in the morph list.

Contents
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Base morph

Required markers

Base morph

Required markers

EyelidLowerDownUp

Lower eyelid markers or image recognition

MouthCornersDownUpLeft

Mouth corner markers

EyelidLowerDownUpLeft

Lower eyelid markers or image recognition

MouthCornersDownUpRight

Mouth corner markers

EyelidLowerDownUpRight

Lower eyelid markers or image recognition

MouthNarrowWide

Mouth corner markers

EyesLeftRight

Image recognition

MouthLeftRight

Mouth corner markers

NostrilFlare

Nostril markers

MouthSneer

Non centered upper lip markers, mouth corner markers

NostrilFlareLeft

Nostril markers

MouthSneerLeft

Non centered upper lip markers, mouth corner markers

NostrilFlareRight

Nostril markers

MouthSneerRight

Non centered upper lip markers, mouth corner markers

NoseWrinkle

Nose wrinkle markers

CheeksBalloon

Cheek markers (lowest are used)

NoseWrinkleLeft

Nose wrinkle markers

CheeksBalloonLeft

Cheek markers (lowest are used)

NoseWrinkleRight

Nose wrinkle markers

CheeksBalloonRight

Cheek markers (lowest are used)

Smile

Mouth corner markers

CheeksFlex

Squint markers (lowest are used)

SmileLeft

Mouth corner markers

CheeksFlexLeft

Squint markers (lowest are used)

SmileRight

Mouth corner markers

CheeksFlexRight

Squint markers (lowest are used)

LipStretch

Mouth corner markers

CheeksDimple

Cheek markers (lowest are used)

LipStretchLeft

Mouth corner markers

CheeksDimpleLeft

Cheek markers (lowest are used)

LipStretchRight

Mouth corner markers

CheeksDimpleRight

Cheek markers (lowest are used)

LipsInPucker

Mouth corner markers

CheeksSmile

Any cheek marker (average is used)

Snarl

Mouth corner markers, non centered upper lip markers

CheeksSmileLeft

Any cheek marker (average is used)

SnarlLeft

Mouth corner markers, non centered upper lip markers

CheeksSmileRight

Any cheek marker (average is used)

SnarlRight

Mouth corner markers, non centered upper lip markers

Frown

Mouth corner markers, any lower lip marker (averaged)

FrownLeft

Mouth corner markers, any lower lip marker (averaged)

FrownRight

Mouth corner markers, any lower lip marker (averaged)

PartLips

Any lower lip marker, any upper lip marker, chin (1 or 3)

PartLipsLeft

Non centered lower and upper lip marker, chin (1 or 3)

PartLipsRight

Non centered lower and upper lip marker, chin (1 or 3)

MouthCornersDownUp

Mouth corner markers

Contents
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Key frame reduction

On the key frame reduction tab you can specify the level of
change after which a new key frame must be created. A value of
0 will create a key frame on every frame.

Output directory

On the Output directory tab you can specify the default directory
the save file dialog window should start in. If you have Poser ®
installed Zign Track will automatically detect the content
directory of the latest Poser ® version that is found.
Select the option "Custom directory" if you prefer to store the
PZ2 files elsewhere. Zign Track will remember the last used
directory when you export the PZ2 files.

Contents
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Animation: Master ACT
There are two exporters for Animation: Master. One will generate
a face rig model, the other will generate an action file containing
your motion capture data. You will need Animation: Master
version 13 or higher.
Face rig
Zign Track creates the face rig you see in the 3D preview in an
Animation: Master model file. This rig will suit your motion
capture data perfectly and this will save you the trouble of
building a face rig yourself. If you are using a model that is only
controlled using poses you do not need this face rig.

scale the face rig to the correct size. In the neck bone properties
set "Attached to parent" to 'ON'. Now you can adjust the
position and scale for the facial bones to line them up with your
model's face. If everything is positioned well you can start
weighting the face. Note that this rig contains lip curl bones. If
you want to use lip curling attach these bones to the lips and the
area around the lips to the lip bones (partially weighted). If
you're done weighting you can test the Zign Track action. Place
your model into a choreography, import the Zign Track action
and drag it onto your model. (or test it in an action window).
Selection

To create your face rig go to the menu Project > Export motion
capture data > Animation: Master > Face rig. Select a location
and file name for your rig model and click "Save".
Importing the rig in Animation: Master is easy: Open your
project with your character model in Animation: Master. Right
click the Objects folder in the PWS (Project Workspace) and
choose Import > Model (*.mdl). Locate your face rig model and
import it. Now you will have to copy the rig to your character
model, which should be already in the PWS. In the PWS select
your model in the Objects folder and expand the bones tree to
at least the chest bone (or other bone you want to attach the
face rig to). Expand the bones folder for the face rig model as
well, and now drag the neck bone onto the chest bone of your
character model. This is all done in the PWS, not in the model
window.
Now you'll have to position the face rig. Select the neck bone
and press 'N' for translate mode. Now you can drag the face rig
on top of the chest. With the neck bone still selected, press 'S' to
Contents

On the "Export selection" tab you can select which recorded
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blocks you want to export. For projects based on a prerecorded
video there will always be only one block. If you want to use a
face rig in your character model you should enable "Export bone
rotations". Zign Track will automatically generate names for each
bone. If you're using a face rig generated by Zign Track the
names will match and it will work as soon as you apply the
action to your model in A:M. If you choose to use your own face
rig you will have to edit the bone names in the action (this can
be done in the PWS) or change the bone names in your face rig
so they will match the action files generated by Zign Track.

the option "Export poses". You can edit your poses on the Pose
settings tab.
Generating poses for A:M actions works exactly the same as for
Poser® PZ2 files. See the the paragraph Morphs for Poser® and
the morph list for more details. Note that the 'poses' are called
'morphs' in Poser®. For the A:M actions the min and max values
are set in percentages, with 100% as a default maximum range.
Key frame reduction

Poses

If you want to drive your model using poses you should enable
Contents

On the key frame reduction tab you can specify after how much
change a new key frame must be created. A value of 0 will
create a key frame on every frame.
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Troubleshooting guide

Face rig is not or partially moving

If you are having trouble, see if you can find a solution for your
problem in this troubleshooting guide. If you cannot find the
answer here or elsewhere in this manual, contact Zign Creations
for support via the support page on www.zigncreations.com.

This can have several causes. You should read the chapter Facial
motion capture from live input or Facial motion capture from a
video file carefully and follow each step. If you're doing it for the
first time, don't rush it. Take your time to get familiar with the
software and you'll notice it will all become very easy once you
understand what Zign Track can and cannot handle.

Cannot import video
Zign Track will need the correct decoders to be able to import
your videos. If you're trying to import a video of which the
CODEC has not been installed on your system you will need to
download the correct CODECs. A good CODEC package with
support for most compression formats is available for free at
http://ffdshow-tryout.sourceforge.net
If you are unable to find a CODEC for your video you should
save your videos using another compression type (encoder).

Camera does not render
Some web cameras specify a lot of available video modes and
fail to connect at some of those modes. If your camera has a 24bits mode you should try this one first. If it fails to connect at a
specific resolution, try another resolution. Always make sure the
drivers for your camera are up to date.
If you're having trouble getting an HDV camera working, see
HDV camera does not render for more details.
If you're not able to render your camera at all, contact Zign
Creations
for
support
via
the
support
page
on
www.zigncreations.com. Please specify as much details as
possible for your camera, including the driver version and
operating system/version you are using.
Contents

If you're upgrading from Zign Track version 1: forget all you
know about version 1 and follow this manual carefully. Zign
Track 2 is a completely different product. Your old methods for
version 1 will not work in Zign Track 2.

Markers are not or badly detected
You should make sure you are using good markers and have
your scene well lit without any objects within view that may
confuse the tracking algorithm. Read the chapter Facial markers
and follow the instructions.
If the markers are good, check your tracking options.

Warning messages
Missing markers
If you're seeing a warning icon with the message "Missing
markers" while you are tracking/playing a video, or during live
input, it means Zign Track was not able to detect enough
markers to get a match with the specified marker layout. Use the
marker preview to see how well your markers are being
detected. Also make sure you have selected the correct marker
layout.
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Noise detected
If you're seeing a warning icon with the message "Noise
detected" while you are tracking/playing a video, or during live
input, it means Zign Track is detecting more markers than
specified in the specified marker layout. Use the marker preview
to see what is causing the noise in your video input. Adjust the
tracking options if necessary. Also make sure you have selected
the correct marker layout.
No match
If you're seeing a warning icon with the message "No match"
while you are tracking/playing a video, or during live input, it
means Zign Track was able to detect the correct number of
markers but was not able to solve the face. If this happens you
have to make sure the marker layout on the actor's face does
not differ too much from the specified marker layout. A likely
cause of this problem is the neck or forehead marker being
placed either too low or too high. This will cause incorrect
scaling of the marker reference, making it harder on the solving
algorithm to find the correct markers. This problem should be
solved by making sure the marker set up on the face does not
differ to much from the specified layout.

Contents
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